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Dragon Medical One Installation Checklist
|:| Update Windows OS

I:l Restart computer

I:l Temporarily disable antivirus

|:| Add DMO web addresses to Trusted Sites
|:| Install DMO using StandAlone

|:| Add DMO Web Extension

|:| Antivirus Excludes
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Introduction » Dragon Medical One User Profile Information

A. Introduction

Dragon Medical One User Profile Information

Install Dragon Medical One (DMO) on as many PC computers as required.

Each user of DMO may have their subscription implemented on the same computer without compromising one another’s
DMO user profile (only use your subscription account of DMO; never any one else’s).

As the DMO user profile is in the cloud, learning and refinements are updated in the cloud and available to you no matter
which computer you use.

If you wish to password protect your DMO account, please .
Weblinks in this PDF

There are weblinks throughout this guide. As such, please view and use this guide on the computer where DMO is to be
installed.

Speakeasy Solutions
The weblinks look like this: Speakeasy Solutions. As required, Dragon

please click these links to load external resources or download Medical One Nuance’
discussed files. StandAlone Dragon®

Video Installation Medical

Guide & Video
In addition to this PDF guide, Speakeasy Solutions provides a one

chaptered 10 minute IDMO Installation Vided. I @ I speakeasysolutions.com

1-888-964-9109

TeamViewer

Speakeasy Solutions utilizes TeamViewer (a remote desktop viewing application) and a telephone call when providing services.

If TeamViewer is not present, ldownload the small Speakeasy Solutions TeamViewer apﬂ to your computer (either the
Downloads folder or Desktop) ahead of time. TeamViewer is not active until you click on the downloaded TeamViewerQS.
exe file to open the application.

Prior to services, please restart your computer and open the TeamViewer application.

Service Appointments

Speakeasy Solutions offers installation, training, and support appointments. To arrange, please contact us by telephone (604-
264-9109 or 1-888-964-9109) or book your appointment on-line as follows:

» Webpage: Epeakeasy Solutions Appointment Schedulind

Category: Choose "Dragon Medical"
Service: Choose "Installation" or "Training" or "Technical Support"

Time: Choose your time zone, followed by a date and available time

vVvyyvy

Provide Information: Enter your name, email, phone, plus other relevant information
» Click: "Done"

Thank youl
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PC Requirements

B. PC Requirements

PC Hardware & Specifications

Speakeasy Solutions recommends the following minimum specifications for Dragon Medical One:

» OS: 64-bit Microsoft Windows Professional Operating Systems (version 10 or 11), with latest patches applied.
» .NET: Microsoft NET Framework 4.7.2 (or higher) is required.

m  To be system ready for future upgrades of DMO, NET Framework 6 is required. As such, if you need to
install NET 4.7.2, consider installing 6.

» Microsoft Edge WebView2 Runtime: See below for verification.
m  On your computer, open Windows Apps & features. You can search using "apps & features".
m  In Apps & features, search using "WebView2". If WebView2 is installed, it is presented at the bottom.
m If itis not present, install WebView?2 Evergreen Standalone component via .
» Processor Speed: 2.8Ghz.
RAM: 8GB.
» Internet Connection: 80kBps and higher.
m  DMO only uses about 10 KB/s upstream per user(translated to about .08 Mbps) and 2-8 KB/s down (.064
Mbps).
» Microphones: Android or iOS smartphone, or a quality microphone such as the Philips SpeechMike handheld or
Sennheiser headset.

v

» Web Browser: Google Chrome and Microsoft Edge version 104 or later.

Internet Access Requirements

Dragon Medical One is a cloud-based speech recognition solution. An organization will frequently have firewall rules and /
or content filters which limit internet access. In order to install and propetly operate DMO, you must be able to access the
following Internet domains and ports.

URL/IP Address Port(s) Resource
dragonmedicalone.nuance.com 80 Software distribution and installation, training videos.
IP: 208.94.121.126
*.nuancehdp.com 443 Secure channel for speech recognition service.

IP: 208.94.121.222
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Before You Install » Internet Access Requirements

C. Before You Install
1. Check and apply |Windows Operating System updateﬁ.

2. Restart your computet.

3. Temporarily disable your antivirus if the application permits this (see your antivirus’ documentation).

ENDPOINT SECURITY

?
PROTECTION STATUS €) Computer ?

Real-time file system protection

Q C\Users\AlexandriaCarstens\AppData\Roa..\82

m Device control

Disabled permanently

£

19452f33aaa5.tmp

@ Host Intrusion Prevention System (HIPS)
Enabled: detection and prevention of unwanted behavior fro

o) Advanced memory scanner
Enabled: detection o

ed threats directly in memory
[ o) Exploit blocker
E ona

Ransomware shield
[ o)
Enabled: p on agains

G Presentation mode

Paused: performance optimizations for games and presentation

@ Pause Antivirus and antispyware protection

1 Import/Export settings ¥ Advanced setup

g Disable Real-time file system protection?

Disabling real-time file system protection, even for a short time, is dangerous and will make your computer
vulnerable to viruses and other threats.

et - e

ENDPOINT SECURITY

A PROTECTION STATUS €) Computer

O\ COMPUTER SCAN _ Real-time file system protection o
Paused: immediate detection and cleaning of malware on your compute

e T .

x UPDATE fo ) Device control

Disabled permanently

53 seTup @

e

@ Host Intrusion Prevention System (HIPS)
Enabled: detection and prevention of unwanted behavior fro
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Add DMO Web Addresses As Trusted Sites B Open Internet Options

D. Add DMO Web Addresses As Trusted Sites

Open Internet Options

If you cannot find Internet Options on your computer, press the [Windows] + [s] keys on your keyboard to initiate a
search. @Type Internet Options into the search text area. Internet Options appears at the top of your search. @ Click to open
these settings. More information from Microsoft.

Al Apps Documents Web  More ¥

Best match

‘lﬂ Internet Options \ 1 » e
y -pe

Control panel 4
Settings
& Block or allow pop-ups >

Search work and web

L internet options - See work and web N
results
£ internet options menu >
L internet options in edge >
L internet options settings >
£ internet options for windows 10 >
L internet options control panel >
L internet options google >
L internet options settings windows 10 >

o

internet options o
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Add DMO Web Addresses As Trusted Sites » Adjust Internet Options' Trusted Sites

Adjust Internet Options' Trusted Sites
Click the @ Security tab.

Click @ Trusted sites and then © Sites.

Internet Optior oo [B]  [=] w0 ? X

1

General Security Privacy Content Connections Programs Advanced
Select a zone to view or change security settings.

@ 0/ O

Internet Local intranet PEIEEEEIES Restricted sites

Trusted sites

/ This zone contains websites that you 3

trust not to damage your computer or
your files.
You have websites in this zone.

Security level for this zone
Allowed levels for this zone: All
Medium

- Prompts before downloading potentially unsafe content
- - Unsigned ActiveX controls will not be downloaded

[] Enable Protected Mode (requires restarting Internet Explorer)

Custom level... Default level

Reset all zones to default level

Add the following three URLs by copying and pasting (one URL at a time).

Highlight text below and press [Ctrl] + [c] on the keyboard.

1

2. OPaste the copied text into the text region (press [Ctrl] + [v] on the keyboard).
3. @Click .4dd.
4

Repeat for the remaining two URLs.

https://www.dragonmedicalone.nuance.com

*.nuancehdp.com

https://dragon.ca.dmp.nuance.com

O Click Close.

Trusted sites on B [ o X

You can add and remove websites from this zone. All websites in
~ this zone will use the zone's security settings.

idd this website to the zone:

[ httpsy//wwnw.dragonmedicalone nuance.com| ] Add [Ql
Websites:

https://speakeasysolutions-files.sharepoint.com A
https://speakeasysolutions-myfiles.sharepoint.com
https://www.dragonmedicalone.nuance.com
https://www.nuancehdp.com

Remove

v

[] Require server verification (https:) for all sites in this zone,

Close
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Install Dragon Medical One Using StandAlone » With StandAlone You Can...

E. Install Dragon Medical One Using StandAlone
With StandAlone You Can...

Password Protect Your Logon

StandAlone installations allow you to password protect your DMO account. If you have installed DMO using Speakeasy
Solutions' configuration files, the password is in place using the SeS-DMO-Password.zip. .

Run DMO from a USB Memory Stick

You may also use DMO from a USB memory stick (thumb drive). This is convenient if you are using a computer where DMO
has not been installed.

With DMO closed, copy the Standalone folder (after replacing the configuration file 1) onto your memory

stick. Insert the memory stick into any Windows OS computer, running the SoD.exe from within the Standalone folder.

If at all possible, and the requisite sites to the computet's Internet options (Eee page Q). Moreover, if you are using a web-
based EMR,add the DMO web extension to the computer you are using as well (Eee page 24).

Use a microphone plugged into the same computer or use your smartphone as a microphone with the smartphone's PowerMic
Mobile app. See lI’owerMic Mobile Installation Instructionsl.

Use English and French Languages

If you need to dictate in the French language as well as English, modify the configuration file (SoD.exe.config) within the

StandAlone folder. .

Change the Default User Interface Colour Scheme

If you have installed DMO using Speakeasy Solutions' configuration files, the default is set to System which reflects the colour
scheme designated by computer system. If desired, change the colour scheme to dark, light, or DMO blue. .

You must complete every step in the following 6 pages.
In summary:

|:| Download the StandAlone.zip

I:l Unblock the StandAlone.zip within its properties

|:| Unzip the StandAlone.zip

|:| Download 1 of 2 available .ZIP configuration files

I:l Unzip and move the .ZIP contents (2 files) into the previously unzipped Standalone folder

|:| Create an icon to run DMO 1)
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Install Dragon Medical One Using StandAlone » Download the Application

Download the Application

The DMO application is in .ZIP format. Click to view the following page: https://dragonmedicalone.nuance.ca/|
EtandAlone / dragonmedicalonel

Do NOT click on the MSI deployment package as this is for large scale deployment.

Scroll down until you see Download XCOPY package. Click this link to initiate the download of the .ZIP file.

rfﬂ D m Dragon Medical One

dragonmedicalone.nuance.ca

Installation  Virtual PowerMic  Mobile Documentation  Service  Technical
packages environments  Mobile device status support
management

XCOPY deployment package 2023.3 (v23.4.64.0)

In larger systems and virtual deployments, the XCOPY installation package enables you to
deploy Dragon Medical One using simple file copy operations. You can customize the
application flexibly by editing the application configuration file; for more information, see the
Installation and Administration Guide.

For more information on how to deploy your application in a virtual environment see: Virtual
environment support.

J; Download XCOPY package
- U

Note: Depending on your Group Policy security settings, Windows might mark downloaded
files as unsafe. Unblock the .zip file, if necessary, to allow proper execution of Dragon Medical

One when started: Right-click the .zip file and select Properties; on the General tab, click
https://ccpvdmondastor.blob.core.windows.net/release/version/23 .4.64.0/CA/StandAlone.zip?sv=2019-02-028sr=b8si=ReleasePolicy&sig=9cA%2FOAWZPSHO...

Once initiating the download, do not Open the .ZIP file but rather save it.

Internet Explorer on [B [ w0 X

What do you want to do with StandAlone.zip?

Size: 69.2 MB
From: dragonmedicalone.nuance.com

—> Open

The file won't be saved automatically.

— Save

—> Save as

Cancel

Once saved, open the folder where the .ZIP file was saved.

The StandAlonezip download has completed. Open vl Open folder I View downloads

© 2025 Alexandria Carstens of Speakeasy Solutions Inc.
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Install Dragon Medical One Using StandAlone » Unblock the Zipped Folder From Its Properties

Unblock the Zipped Folder From Its Properties
From Windows Explorer, @right click the StandAlone.zip folder.

@ Click Properties.

I Extract C:\Users\AlexandriaCarstens\Desktop\DMO

File Home Share View Compressed Folder Tools

L\j J & Cut < B x iﬁ 7 New item ~ \ﬂ ’,.,S::mv H

W Copy path T | Easy access ~

PintoQuick Copy Paste Move Copy Delete Rename — New Properties
access L] Pasteshortaut 0 o~ - folder - sy 5
Clipboard Organise New Open
™ > ThisPC » Desktop > DMO v U
" Name Date modified
3t Quick access
i 7 2021 04 142.00 Dna
I Desktop i StandAlone.zip a
Open
¥ Downloads

Open in new window

© share with Skype

Extract All...

® Scan with ESET Endpoint Security

Advanced options >
Pin to Start
Upload using WS_FTP Upload Wizard

|& Share
Open with >
Give access to >

Restore previous versions

Send to >

Cut
Copy

Create shortcut
Delete

e‘ Rename

Properties I
" I

Check @ Unblock. Click @ Apply. Click @ OK. If Unblock is not present, close the location folder and try again.

Bl StandAlone-21.1.18.0zipPlopltZks  [2] o

General Security Detais Previous Versions

StandAlone-21.1.18.0 zip

Typeoffie:  Compressed (zipped) Folder (zip)

Opens with: ", Windows Explorer Change.
Location \WfserverCompany Drive\speakeasy\10Products_Sup
Size: 70.1 MB (73,582,291 bytes)

Size ondisk:  70.1 MB (73,588,736 bytes)

Created: March 16,2021, 11:14:20 AM
Modified: March 16, 2021, 11:14:23 AM

Accessed: April 10, 2021, 11:46:41 AM
Attributes: [ _]Read-only [] H\ddeno Advanced.
Security: This file came from another

computer and might be blocked tg

help protect this computer.
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Install Dragon Medical One Using StandAlone » Unzip the Dragon Medical One StandAlone File

Unzip the Dragon Medical One StandAlone File

Unzip the DMO file (StandAlone.zip) to your desktop, Documents folder, or another location. Right click StandAlone.zip
and choose Extract AJl... from the drop down.

» DMO v
Name Date modified
i StandAlonezip 2021-04-142:24 DA

Open
Open in new window

© Sshare with Skype

Extract Al I
s

oint Security

Advanced options >

X
L]

Select a Destination and Extract Files

Files will be extracted to this folder:

[C:\Users\AlexandriaCarstens\ Desktop\DMO\StandAlone Browse...

I Show extracted files when complete I

Cancel

= 37% complete

Copying 3,361 items from StandAlone.zip to StandAlone
37% complete " x

More details

For unzipping/extracting instructions, visit this lMicrosoft website support pagel.

Deploying the Speakeasy Solutions Modified SoD.exe.config File

For your convenience, Speakeasy Solutions provides you with 2 different modified configuration files (required to run DMO)
based on your needs. The contents of these folders replace the unzipped files within DMO's Standalone directory you
unpacked in the previous step.

Download

Download one of the following two as appropriate by clicking on the link (either Not Password Protected or Password
Protected):

© 2025 Alexandria Carstens of Speakeasy Solutions Inc.



https://support.microsoft.com/en-ca/help/14200/windows-compress-uncompress-zip-files

Install Dragon Medical One Using StandAlone » Deploying the Speakeasy Solutions Modified SoD.exe.config File

|N0t Password Protected — the most common. Dragon Medical One opens to the default login screen.

Nuance®
Dragon Medical RomTaon

Speakeasy Solutions v

Headset Microphone (Sennheiser SD)
English (United States) v

General Medicine 2

| Bt |
4 Speakeasy

Solutions

1-888-964-9109 W g NUANCE

ions, Inc. Al rights

or

Password Protected — running DMO requires you to enter a password on the login screen. This is useful for shared
computers, preventing the development of recognition inaccuracies that occurs when others use your DMO subscription
account/user profile.

Nuance®

Dragon Medical RomkiTaon
|
| o et |

4 Speakeasy

Solutions

1-888-964-9109 N g NUANCE

ions, Inc. Al rights rved. 20 4.64.0)

Unzip & Copy/Move

Unzip the downloaded file from above and open the resulting folder.

Name

Open
Open in new window

Share with Skype

3

Extract All...
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Install Dragon Medical One Using StandAlone » Create an Icon to Run Dragon Medical One

Copy or move the contents of the folder into the Dragon Medical One Standalone directory.

n B - [ DMO - Organization Token

File Home Share View

[. n [ Extra large icons B Large icons . [.l M Item check boxes
& dium icons E Small icons
Navigation ) 7 Sort
par-na' = BE st § Details by~ i ¥| Hidden items

Il - ¥ File name extensions

Hide selected = Options
items e

Panes Layout Current view

<« 1+ Dragon Medi... DMO - Organization Token

0 3D Objects

Name . Date
I Desktop

# soD.exe.config
M SoD.OEM.png

2023-08-25 2:38 PM
2023-08-22 12:52 PM

E Documents
Downloads
Music

BH Pictures *

£ Videos
2items | 2items selected 99.4 KB |

When prompted, click Replace the file and the destination.

m Replace or Skip Files

Copying 2 items from DMO - Organization Token to Standalone

The destination already has a file named
"SoD.exe.config"

v Replace the file in the destination

) Skip this file

4» Compare info for both files

Fewer details

Create an Icon to Run Dragon Medical One

The StandAlone DMO application file is within the unzipped Standalone folder. The application file (.exe file) is SoD.exe.
SoD is an abbreviation of Speech on Demand, for those who are curious.

© 2025 Alexandria Carstens of Speakeasy Solutions Inc.



Install Dragon Medical One Using StandAlone P Create an lcon to Run Dragon Medical One

B ¥R

File

Home

View

P

Y 3D Objects
| Desktop

E Documents

rge icons B3 Large icons
s E Small icons
E Details

a it

on Medical One v23

A

Standalone

Name

B c.monnaa An

Item check b '
Hide selected
items

+| File name extensions

¥| Hidden items

Date modifie

4

SoD.exe
M c.n @ A
File description: SoD
5 Company: Nuance Communications, Inc.
B SoD.IEEdi File version: 23.4.64.0
Date created: 2023-08-14 5:55 AM
Size: 948 KB

Downloads
Music
BH Pictures

£ Videos

324 items | 1item sel

Right click the SoD.exe file and choose any of the following:

» O Open — runs the DMO application file.
@® DPin to Start — pins the application to the Start Menu.

© Py fo taskbar — pins the application to the taskbar.

vVYvyy

the shortcut

O Send to > Desktop (create shortent) — creates a shorteut to the application on your desktop.

if you wish.

T o
2 & cut 2 x lﬁ T New item ~ [ Open ~ [ selectall
E v
\J J M Copy path L T Easy access ~ J Edit Select none
Pinto Quick Copy Paste Move Copy  Delete Rename  New Properties .
access 18] Pasteshortaut | oo - - folder - lgHistory (1] Invert selection
Clipboard Organise New Open Select
<« v > This PC > Desktop > DMO » StandAlone > Standalone v o L Search Standalone
) - e . ~
o Creative Cloud Files Name Date modified Type Size
™ This PC 2021-03-22 12:50 PM Application extension 1,658 KB
X — Application 414 KB
3D Object:
’ jects oD exe.conig o Open) CONFIG File 13 K8
o [7] SoD.exe.manifest & Run as administrator MANIFEST File 4K8
¥ Documents ] soD.EEditRemotedll | © Share with Skype Application extension 1,816 kB
& Downloads %] SoD.IEEditRemote x64, o Toubleshoot compatibility Application extension 2,244 KB
D Music [%] SoD.Interop.UIAdIl 9 Pin to Start Application extension 74K
& Pictures [] soD.Interop.UIA.dll.me @  scan with ESET Endpoint Security METAGEN File 28
B videos [ SoDKpidil Advanced options > | Application extension 49 KB
SoD.| Text D t 1Ke
.. Local Disk (C3) &l SoDlog & share ext Document
[ SoD.log20210414 LOG20210414 File K8
[%] SoD.LogonServices.dll Give access to > Application extension 601 KB
v oD.Recorder. pload using WS_| pload Wizar pplication extension v
% 50D.Recorder.dll Upload using WS_FTP Upload Wizard Applicati i 33ke
248items 1 item selected 413 KB Pin to taskbar =
Restore previous versions
Send to > 0 Bluetooth device
cut i Compressed (zipped) folder
Copy I Desktop (create shortcut) g
[Z Documents
Create shortcut .
=/ Faxrecipient
Delete - Al sttt
Mail recipient
Re
ename TeamViewer
Properties ~ SES-ALEX (E)
DVD RW Drive (F;) DVD_VIDEO
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Start Dragon Medical One » Running/Opening Dragon Medical One

F. Start Dragon Medical One

Running/Opening Dragon Medical One
Upon running Dragon Medical One (double-clicking the icon), if you see the following Error message, click OK.

An error has occurred, it is not possible to use the application.
Please contact your administrator.

The specified server URL cannot be reached. Check the
configured URL and your network connection.

Run DMO again and it will open to the login screen.

If you ever see the following message, simply click OK.

Nuance®

Dragon Medical i

{ Speakeasy

Solutions

1-888-964-9109 & NUANCE

Log In

Log in with your User credentials (the email used to register your DMO account).

Nuance®

Dragon Medical Rt on

o |

‘ Speakeasy

Solutions

1-888-964-9109
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Start Dragon Medical One » Log In

Choose your preferred Microphone.

Nuance®

Desk!

Dragon Medical RO

Speakeasy Solutions v

Headset Microphone (Sennheiser SD)

Headset Microph: sD)
Stereo Mix (Realtek USB Audio)
Microphone (Sonic Studio Virtual Mixer)
Microphone (ARUSBA-UCD)

Nuance PowerMic Mobile

{ Speakeasy

Solutions

1-888-964-910 B @ NUANCE

4.0)

The default Language option is English (US). 1f you have added the French language as an option (i Canadian

French is listed here as well.

Nuance®
Desktop

Dragon Medical

Headset Microphone (Sennheiser SD)

English (United States) M
| English (United States)
frangais (Canada)

{ Speakeasy

Solutions

1-888-964-9109
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Start Dragon Medical One » Suggested Settings

Select the Speciality that is most appropriate. The Clinical Administration vocabulary is non-medical and suitable for general
dictation such as email, personal correspondence, and similar.

D
One

User:
The device you have selected is not Speakeasy Solutions v
ded; the ding quality
might not be good enough for speech
recognition.

Microphone:

Headset Microphone (Sennheiser SD)
Language:

English (United States) M

Speciaity
|

General Medicine M

General Medicine

Clinical Administration
Radiology

‘ SPe(] keq Sy Cardiology

Emergency
Solutions Internal Medicine
Mental Health

1-888-964-9109 Neurology

Orthopedics

© 2011-2023 Nuance Communications, Inc. All rights reserved.

4.0)
Obstetrics and Gynecology

Oncology
Pathology
Pediatrics

Surgery

Suggested Settings

Click the DragonBar Menu Icon on the right side of the DragonBar.

‘ Open the Dragon menu

Click Options.

Speakeasy Solutions

Log Off...

Microphone

Options...
Manage Auto-texts...
Manage Step-by-step Commands...

Manage Vocabulary...

Show/Hide Dictation Box
Show Most Recent Message

Show Log File

Help
What You Can Say

Exit

While these are all personal preferences, often based on workflow, consider the following as suggested settings.
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Start Dragon Medical One » Suggested Settings

General

OSome users find that Enabling the wake word feature elicits a slower response from DMO, particularly in noisy environments.
Disable this feature if you find this so.

@®1f you find the cursor is relocating inside the Dictation Box, uncheck Optimize for rapid navigation.

General I Speech focus

Text Input

[ Anchor the speech focus when recording is started

Hotkeys Voice commands

Microphone Buttons X . R
Visual feedback when voice commands are recognized

Data Collection DragonBar "

[] Audio feedback when voice commands are recognized
Wake word
o ] Enable wake word feature
Start Dragon in standby mode
Dictation
9 [] Optimize for rapid navigation
Auto-text fields

Left field delimiters:

Right field delimiters:

ApplyAl | | Close | [Restore Default
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Start Dragon Medical One » Suggested Settings

Text Input

O On the Text Input tab, there are two methods for inserting text in a text region where the ability to select, correct, and affect
text etc. is not available:

» the Dictation Box ot
»  Using Basic Text Control.

If your accuracy is not yet at an acceptable level for you, consider using the Dictation Box where you have complete control
over the text and related voice commands.

If, on the other hand, you are satisfied with your achieved accuracy, use the Basic Text Control method, allowing you to dictate
and have DMO?’s transcription appear at the cursor. If using Basic Text Control, call up the Dictation Box any time you need
to using a voice command ("show Dictation Box"), keystroke, or button press on your microphone (if available).

@ Adjust the General Settings for the Dictation Box based on your workflow (discuss with Speakeasy Solutions if need be). It is
always prudent to enable Keep fext on Clipboard after transferring so that if text does not appear where you expect or at all, repos-
ition the cursor and paste the saved to clipboard text (press [Ctrl] + [v] on the keyboard).

© Choose the font type and size that reads most easily when using the Dictation Box. This is a personal preference.

General

What happens when the cursor is placed in an unknown text field?

| Text Input I @ Open the Dictation Box: Use your voice to dictate, correct and navigate; transfer the text afterwards.

O Use Basic Text Control: Dictate at the cursor without the ability to format, correct and navigate using your voice.

Hotkeys
Q The ring around the microphone icon indicates you are using Basic Text Control.

Microphone Buttons

Data Collection
Text transfer method

@® Press Shift+Insert
O Press Ctrl+V
O Use Windows paste command

O Simulate keystrokes
Dictation Box: General settings

[] Transfer text when recording is stopped
Clear Dictation Box after transferring text
Keep text on the Clipboard after transferring
e [] Add the selected text from the target application to the Dictation Box
Show Dictation Box when the DragonBar is minimized

[] Audio alert when Dictation Box opens automatically

Dictation Box: Text appearance

@ Plain text
Font type:

e Arial v

Font size:

12 s

O Formatted text

Apply Al p—
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Start Dragon Medical One » Suggested Settings

Hotkeys

The Hotkeys tab is useful for those who prefer keyboard shortcuts for functions.

General General
Text Input Ctrl Alt Shift

Show/hide DragonBar: O H
Microphone Buttons || Start/stop recording: O O 1 [NUM-Add

Data Collection
Anchor/release speech focus: O A

Dictation Box

Ctrl Alt Shift
Show/hide Dictation Box: O b

Transfer text: O T
Clear Dictation Box:
Recall text:
Field navigation
crl Alt Shift
Previous:
Next:
Field complete:

Accept defaults:

Step-by-step commands @

Apply Al p—
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Start Dragon Medical One » Suggested Settings

Microphone Buttons

The Microphone Buttons tab is useful for those with a handheld microphone such as a Philips SpeechMike, or who is using
the PowerMic Mobile app on their smartphone. Assign the buttons per your needs and workflow (discuss with Speakeasy
Solutions if desired). Below is an example of a popular configuration for power users of DMO.

Options x

General
Text Input
Hotkeys

- Press Hotkey e Accept Defaults v
Microphone Buttons

ctrl At Shift

Data Collection O 0O Tab

Press Hotkey e Show/Hide DragonBar v

ctrl At Shift

O O O meb

Previous Field M <None> v

Microphone On/Off e

[] Enable wake word feature

Start Dragon in standby mode

Transfer Text M

Next Field M

Field Complete e

ApplyAl | | Close | [Restore Default

© 2025 Alexandria Carstens of Speakeasy Solutions Inc.




Dragon Medical One Web Extension » Google Chrome & Microsoft Edge

G. Dragon Medical One Web Extension

If using a web-based EMR, we highly recommend using Google Chrome, enabling you to dictate directly into the EMR
without requiring the Dictation Box. Install the Dragon Medical One Web Extension.

The Google Chrome web extension, providing compatibility with DMO, is used within the Google Chrome web browser, and
is also used within the Microsoft Edge and Opera web browsers.

Outlined below is the method for adding the Google Chrome web extension in the Google Chrome and Microsoft Edge
web browsers. The screen captures below are from Google Chrome. Microsoft Edge is very similar, with slightly different
terminology.

If you use Opera and/or Vivaldi, perform the same procedure.

Due to Mozilla Firefox's policies, Firefox does not permit the creation of a DMO Web Extension at this time. There ate third-
p > p

party "hacks" allowing the installation of Google Chrome web extensions within Mozilla Firefox, but Speakeasy Solutions

does not recommend using these for security reasons.

Google Chrome & Microsoft Edge
Copy the URL below (select text and press [Ctrl] + [c] on the keyboard):

https://chrome.google.com/webstore/detail/dragon-medical-one-web-ex/ feolagkacappiaicohahjkeaikhjjcfa
Position the mouse cursor into Google Chrome’s address bar (press [Alt] + [d] on the keyboard).
Paste the above copied text into the address bar (press [Ctrl] + [v] on the keyboard).
Press the [Enter] key. Google Chrome’s DMO web extension page opens.

New Tab

cl e https://chromegooglecom/webstore/detail/dragom—medica\—one—web—ex/feolagkacapp\aieohahjkeaikmcfa‘

H# Apps @ @  https://chrome.google.com/webstore/detail/dragon-medical b-ex/feolagkacappiaieohahjkeaikhjjcf:

Q  https://chrome.google.com/webstore/detail/dragon-medical-one-web-ex/feolagkacappiaieohahjkeaikhjjcfa - Google Search Bages

Google

Q. Search Google or type a URL )

P L L L L L LLLLLLLLELLLELLLLLLLLLLLELLLLELLLELLLLELLLLLLLELLLLLLLLLLLLELLLSLS

/" Customize
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https://support.office.com/en-us/article/Copy-and-paste-using-the-Office-Clipboard-714a72af-1ad4-450f-8708-c2931e73ec8a

Dragon Medical One Web Extension » Google Chrome & Microsoft Edge

Click Add to Chrome.
on [E] [=] - O X
& Dragon (DMO, DMD, DPA, DLA) X +
< C & chromegoogle.com/webstore/detail/dragon-dmo-dmd-dpa-dla-we/feolagkacappiaieohahjkeaikhjcfa * G » = H
G Apps @) Facebook @ NewTab
£~ chrome web store e

Home > Extensions > Dragon (DMO, DMD, DPA, DLA) Web Extension

(S Dragon (DMO, DMD, DPA, DLA) Web Extension

Offered by: Nuance Communications, Inc.

ok e 18 ‘ Productivity ‘ 2 300,000+ users

Overview Privacy practices Reviews Related

Click _Add extension.

( Add "Dragon (DMO, DMD, DPA, DLA) Web Extension"?

It can:
Dragon (DMO, DMD, DPA, DLA) Web

Read and change all your data on the websites you visit (S Extension has been added to Chrome

C icate with it ti licat . N . .
ommunicate with cooperating native applications Use this extension by clicking on this icon

Manage your extensions by clicking Extensions in the

Cancel Tools menu.

A
Piviery ey s 1y VRS ST I T

Restart Google Chrome.
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Dragon Medical One Web Extension » Google Chrome & Microsoft Edge

The DMO Web extension is viewed under the top right menu of Google Chrome. @Click the menu, @choose More Tools,
O followed by Extensions.

r & Dragon (DMO, DMD, DPA, DLA) = X

<« c @& chrome.google.com/webstore/detail/dragon-dmo-dmd-dpa-dla-we/feolagkacappiaieohahjkeaikhjjcfa/related * B » =
i Apps @) Facebook @ New Tab New tab Ctrl+T
New window Ctrl+N
o chrome Web store New incognito window  Ctrl+Shift+N
History >
Downloads Ctrl+)
Home > Extensions > Dragon (DMO, DMD, DPA, DLA) Web Extension Bookmarks >
Zoom - 100% + r
. Print... Ctrl+P
( Dragon (DMO, DMD, DPA, DLA) Web Extension [ remc
Offered by: Nuance Communications, Inc. Find... Ctrl+F
e More tools » Save page as... Ctrl+S
% %K & 18 | Productivity | & 300,000+ users Create shorteut
£dit Cut Copy  Paste reate shorteut.
Settings )
Help » Extensions

Overview Privacy practices Reviews Related Bt

Developer tools Ctrl+Shift+]

6 &) P ¥

Nuance PowerMic Web ... CSpeak - Browser Interf... DragonLink PatientText Dragon Go Server notifier

ok kA 17 155 users * ok k ok ok 6 Kk hkkAh 6 Yk ok ke 17

Accessing the DMO extension is important for removing the extension when there is a failed update to the extension itself or
other troubleshooting. If there is a problem with the extension, remove the extension, restart Google Chrome, and then add
the extension once again.

P Dragon (DMO, DMD, DPA, DLA) © X [F SIZSuRIN x IS

C @ Chrome | chrome://extensions * B & =

it Apps @) Facebook @ NewTab

= Extensions Q_ search extensions Developer mode @

Dragon (DMO, DMD, DPA, DLA) Web Extension h Google Docs Offline
(6 Dragon Web Extension 5@ Edit, create, and view your documents,
spreadsheets, and presentations — all without
internet access

Details Remove ® Details Remove O

O DL LLLLLLLENNANRS PP LD LLLLLLLLLLLLLLELLLLLLLLLLLLLLLLLLLLLLLLLSS
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Antivirus Excludes » Introduction

H. Antivirus Excludes

Introduction

Excluding DMO related directories from active scanning by your antivirus ensures that DMO functions smoothly. While this
is not mandatory, it could be helpful with respect to DMO?s efficacy and speed.

Consult your specific antivirus’ documentation regarding how to exclude specific directories from active scanning,

Exclude the following DMO file processes:
» SoD.exe

P sodria_nmbhost.exe
»  thunk x64.exe
» SoD.ddcf.dll

Exclusion Method

With DMO running, exclude the DMO related directories in the following fashion:

1. Press [Ctrl] + [Shift] + [Esc] on the keyboard to open the Task Manager.
2. The Task Manager appears as one of the following:

8 Task Mardyer [B] [e] o = O X ¥ Task Manager o [B] =] oo = ] X
~ File Options Vi
Bl Microsoft Excel e Dptions View
Processes Performance App history Start-up Users Details Services
& Microsoft Outlook
~
I3 Microsoft Word 8% 42% 0% 0%
Name Status CPU Memory Disk Network
+] Notepad
~
v SoD (32 bit) (2 0.1%  92.5MB 0 MB/ 0Mb
O Opera Internet Browser @ sop 26 @) s BB
® @ SoD (32 bit) 0.1%  912MB 0 MB/s 0 Mbps
ickBooks (32 bit]
Quickooks (32 bit Thunk Server 0% 13 MB 0 MB/s 0 Mbps
(% ScheduleOnce Connector for Outlook (32 bit) 15 Task Manager 03% 205 MB 0MB/s 0 Mbps
3 snagit Capture % Tiillan (32 bit) 0% 43 MB OMB/s  0Mbps
® soD (32biy) T Windows Explorer (2) 06%  448MB OMB/s  0Mbps
v
% Tiillian (32 bit) v Q >
l‘ More detailsl End task Fewer details End task
[ or

3. ©@Expand the SoD process by clicking on the downward pointing chevron. @Right click SoD (32 biz) (this is
DMO) or Dragon Medical One and ®choose Open file location.

8 Task Manager on B [ o - 0 X 5 Task Manager mOE @
File Options View File Options View
Processes Performance App history Start-up Users Details Services Processes Performance App history Start-up Users Details Services
~ % 43% 0% 0% ~ 19% 46%
e Status CPU Memory Disk Network mi‘ S Status CFU MfTorY
v @ soD (32 bit) (2) 03%  93.0MB 0MB/s  OMbps v @ sob(32bi) (2) 03%  96.0MB
SoD (32 bit) o tack 03% 917 MB OMB/s 0 Mbps @ Dragon Medical One . 03% 947 MB
Thunk Server 0%  13MB  OMB/s  OMbps Thunk Server i) s o IR
5 Task Manager Reso.ume valoes ’ 03%  295MB OMB/s 0 Mbps £ Task M Resource values ’ 0.8%  329MB
Provide feedback by lask Manager Provide feedback g 2
%o Tillan (32 bit) Create dump file 0% 43MB 0Mg/s 0 Mbps % Trillian (32 bit) Gtz dimp e 0%  45MB
‘m Windows Explo, il 0.3% 449 MB 0 MB/s 0 Mbps . < "
< q Open file location E I > Fewer details e I Open file location %O]
Fewer details Properties End task TepEiE

or
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Antivirus Excludes » Exclusion Method

File Explorer’s address bar displays the file pathway of the current folder. Copy the file pathway for pasting into
your antivirus exception list.

Left click inside the File Explorer’s address bar to the right of the folder named content. If the pathway is not
automatically selected but the cursor is in the address bar, press [CErl] + [a] on the keyboard, followed by
[Ctrl] + [c] to copy the pathway to the Windows clipboard.

Manage C\Users\AlexandriaCarstens\AppData\Local\Apps\2.0\QGZNGV2C.0CL\Z9Y65BR0.60C\drag. tion_cbc2839 [5] [e] o

File Home  Share  View App Tools (7]
o Cut <+ x Eﬁ ’{‘J New item ~ @ open ~  H selectall
W] Copy path T ] Easy access ~ Edit Select none
P k C P M C Delete R N P i
o quide CoY PR [ pasteshonaur e ory | Delete Rename - hew PSS Mistory £ Invert selection
Clipboard Organise New Open Select
. NV .
1 <« Z9Y65BR0.60C > drag.tion_cbc27d9%ea78d3bc8_0015.0001_0cce50c5921d5Tef > content e - v L Search content
B 3D Objects Name Date modified Type Size A
I Desktop @ soDexe 2021-04-20 2:27 PM Application 414 KB
\ﬁ Documents 7 SoD.exe.config 2021-04-20 2:33 PM CONFIG File 11 KB
¥ Downloads \j SoD.exe.manifest 2021-04-20 2:28 PM MANIFEST File 4 KB
B Music [#] SoD.EEditRemote.dll 2021-04-20 2:28 PM Application extension 1816 KB
&) Pictures \j SoD.IEEditRemote_x64.dlI 2021-04-20 2:27 PM Application extension 2,244 KB
m Vid = SoD.Interop.UIAdIl 2021-04-20 2:28 PM Application extension 74 KB
ideos -
A2 |1 SoD.Interon.UIA.dll.metaaen 2021-04-20 2:27 PM METAGEN File 2KB a2
26items 1 item selected 413 KB =

4. There should be an exclusions section within your antivirus application. Press [Ctrl] + [v] on the keyboard
into the list of exclusions in your antivirus software.

@ Advanced setup - ESET Endpoint Seafy (2] [=] o X

Add exclusion ?
Path 5921d51ef\content\SoD.exe (i}
Comment (i)

Exclude the following DMO file processes within the content folder:
SoD.exe

sodria_nmhost.exe

thunk_x64.exe
SoD.ddcf.dll
SoD.DAL.SSO.dll
PSPSBEXT.dI
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Editing the SoD.exe.config File » Why Edit the Configuration File

I Editing the SoD.exe.config File

Why Edit the Configuration File

There are a few reasons for modifying DMO's configuration file, as outlined on the following pages.

Opening the Configuration File
Always exit DMO before modifying the configuration file.

Consider copying the file elsewhere prior to any modification so that you may return to this configuration file if need be.

DMO's configuration file is within the unzipped Standalone folder. The file (.config file) is SoD.exe.config.
n || m- H Standalone

File Home Share View

ra large icons ] Large icons . [.] - Item check boxes '
E Small icons

v I~ ¥ File name extensions
Navigation g . . _ Sort Hide selected = Options
pan i E List i Details by ™ ¥| Hidden items s

Panes Layout Curren

<« v 1+ R Dragon Medical One StandAl... Standalone

5 This PC NrmE

9 3D Objects SoD.exe 2023-08-14
P Desktop L. ] SoD.exe.config “ 2023-08-26

2N N0 14
Type: CONFIG File
Downloads Size: 17.3 KB
B soD.EEditRemote x64.dll Date modified: 2023-08-26 3:43 P

E Documents

Music

329items | 1 item selected 17.3KB | i =2
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Editing the SoD.exe.config File » Opening the Configuration File

ORight click the SoD.exe.config file. @ Hover the mouse over Oper with. If Notepad is not listed as an option, Oclick Choose
another app.

m| B = |sStandalone
File Home Share View ~ @

arge icons B La rge icons Item check boxes

dium icons E Sma
avigation . .
4 = ii List i Details

pane

<« DR | Dragon Medical One StandAl... Standalone

3 This PC
) 3D Objects
1 Desktop
E Documents
Downloads

Music

329items | 1item selected 17.3 KB

Name

SoD.exe

¥| File name extensions

¥| Hidden items

v
v
v

Hide selected =~ Options
items <

Date modifie

2023-08-14

L. | SoD.exe.config

Open
I SoD.exe.manifes

B soD.IEEditRemot
B soD.IEEditRemot

Edit

Share with Skype

7-Zip

Scan with ESET Endpoint Security

Advanced options

Share

Open with

Give access to
Upload using WS_FTP Upload Wizard

Restore previous versions

When choosing another app, click More apps. Optionally click Abhways use this app to open .config files so that you do not need to

choose which application you used to edit this file in the future.

bw - Adobe Dreamweaver 2021

# Notepad

B Search the Microsoft Store

Choose another app

Other options

m Adobe Dreamweaver 2021
E Look for an app in the Microsoft Store

s

/ Always use this app to open .config files

OK
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Editing the SoD.exe.config File » Add French Language

Scroll down until you see Notepad. Click Nozepad, then OK.

How do you want to open this file?

. Adobe Photoshop 2023 A
Firefox

Internet Explorer

Notepad N

Opera Internet Browser

Edit as you wish from the various options below.
Save and close the configuration file when finished, and THEN run DMO to test your modifications.

Add French Language

Perform a search for the phrase SupportedLanguages. Beneath this, add the French language (Canadian accent) variable to
the value so that it reads as follows: <value>en-US | fr-CA</value>.

<!-- Languages in the IETF format. To present a list of available languages
to the end user, specify all supported languages in the setting and separate them
with the pipe (|) character (for example, de-DE|en-US|sv-SE|nl-BE). -->

<setting name="SupportedLanguages" serializeAs="String">
I <value>en-US fr—cﬂ</va1ue> I

</setting>

Custom commands and vocabulary items differ between the two languages. In other words, creating a command under the
French language is only available while using DMO in the French language.

Switch between languages when DMO starts or when you log off the current DMO instance. Both English and French are
available under the Language option.

Add Canadian Spelling

Perform a search for the phrase SupportedLanguages. Beneath this, add the English language (Canadian spelling) variable
to the value so that it reads as follows: <value>en-US | en-CA</value>. It is not recommended to delete en-US (American
spelling); you may lose custom commands and words created while you were using the English (United States) language.

<!-- Languages in the IETF format. To present a list of available languages
to the end user, specify all supported languages in the setting and separate them
with the pipe (|) character (for example, de-DE|en-US|sv-SE|nl-BE). -->

< i S ages" serializeAs="String">
<value>en—US\enFCA</value>

< IEETTTE

Custom commands and vocabulary items differ between the two languages and their spelling. In other words, creating a
command under the English (Canada) language is only available while using DMO in the French language.

Switch between languages when DMO starts or when you log off the current DMO instance.
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Editing the SoD.exe.config File » Default Ul Color Theme

Both Canadian English and United States English are available under the Langnage option. You can also add Canadian French.

Nuance®

Dragon Medical

Speakeasy Solutions v
Headset Microphone (Sennheiser SD)

English (Canada)

| English (Canada)
francais (Canada)
English (United States)

‘ Speakeasy

Solutions
1-888-964-9109 & NUANCE

mmunications, Inc. All rights r ved. 34.64.0)

Default Ul Color Theme

Perform a search for the phrase DefaultTheme. Beneath this, add your preferred colout scheme between <value> and </
value> from the values listed above (System or Dark or Light or Blue).

System reflects the colour scheme of your computer. The remainder are self-explanatory.

<!-- Default UI Color Theme Name
Valid values are System, Dark, Light, Blue, and unspecified (empty).
If no setting is specified here the UI will be rendered with the Blue theme. -->

<setting name="DefaultTheme" serializeAs="String">
<value>System
</value>

Password Protect DMO User Accounts/Profiles

Perform a search for the phrase =" Authentication". Beneath this, add native between <value> and </value>.

<l--
Authentication (none/native/ldap/ldaplocal/trusted)
none : No authentication (default)
native : NMS Native
1dap : LDAP/AD
ldaplocal : LDAP local authentication
trusted : Trusted
-->
entication” serializeAs="String">

i o "
<value>native</value>|

Enjoy Dragon Medical One
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"Uninstall" StandAlone DMO » Updates

J. "Uninstall" StandAlone DMO

Updates

Updates are not automatic; Speakeasy Solutions notifies you when there are updates.
When you update, retain or delete the entire Standalone folder, as per your choice.
Removing StandAlone DMO

If you do not know the location of the Standalone folder:

Run DMO.

1. Press [Ctrl] + [Shift] + [Esc] on the keyboard to open the Task Manager.
2. The Task Manager appears as one of the following:

asl ﬂrﬂger o — as| anager o1 e -
#% Task M, = =] O X # Task M, = =] O X
~ File Options Vi
Bl Microsoft Excel e Dptions View
rocesses Performance App history Start-up Users Details Services
= P Perf App hi s Users Details Servi
Microsoft Outlook
il Microsoft Word - 8% 42% 0% 0%
Name Status CPU | Memory Disk | Network
=) Notepad
~
v @ soD BE2bit) 01%  925MB OMB/s  0Mbps
O Opera Internet Browser @ G @ &
@ 50D (32 bit) 01%  912MB OMB/s  0Mbps
@ uickooks (32 bif Thunk § 0%  13MB  OMB/s  OMb
unk Server d s ps
o) )
(% ScheduleOnce Connector for Outlook (32 bit) 455 Task Manager 03% 295 MB 0MB/s 0 Mbps
[ Snagit Capture % Trillian (32 bit) 0% 43 M8 OMB/s  OMbps
® 50D (32 bit) % Windows Explorer (2) 06%  448MB OMB/s  0Mbps
v
o o )
% Trillian (32 bit) v r S
End task Fewer details End task
| or

OExpand the SoD process by clicking on the downward pointing chevron. @Right click SoD (32 biz) (this is
DMO) or Dragon Medical One and @ choose Open file location.

#3 Task Manager on [5] [ ro — O X % Task Manager on =] [=] o
File Options View File Options View
Processes Performance App history Start-up Users Details Services Processes Performance App history Start-up Users Details Services
- 7% 43% 0% 0% - 19% 46%
e Status cPU Memory Disk | Network me Status CPU | Memory
v @ soD 32 bit) (2) 03%  93.0MB 0MB/s 0 Mbps v @ soD(E2bi (2) 03% 960 MB
SoD (32 bit) - 03%  91.7MB 0MB/s 0 Mbps @ Dragon Medical One o 03% 947 MB
End tasl|
Thunk Server ] R 0% 13 MB 0 MB/s 0 Mbps Thunk Server 0% 13 MB
5 Task M Resource vaues 03% 295MB  OMS 0 Mb Resource values ’
{4 Task Manager Provide feedback . b /s ps 15 Task Manager et et T 0.8%  329MB
& T )
"o Tillian (32 bit) Create dump file 0% 43MB OMB/s 0 Mbps % Trillian (32 bit) Gtz dmp(le 0%  45MB
T Windows Explo f 03% 449 MB OMB/s 0 Mbps < "
< d Open file location E I > Fewer details e I O file [t %O]
Fewer details Properties End task Properties
or —
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"Uninstall" StandAlone DMO » Removing StandAlone DMO

4. Close DMO.

5. The File Explorer’s address bar displays the file pathway of the current folder. Click the folder previous to
StandAlone.

Manage C:\Users\AlexandriaCarstens\Desktop\StandAlone\Standalone

File Home  Share  View App Tools (7]
U o Cut < x @ % New item ~ @ open ~  H selectall
Wl Copy path 1] Easy access ~ Edit Select none
Pin to Quick Co Paste Move  Co Delete Renmame New Properties .
access > [ Pasteshorcur 0 Y - folder " @ History [ Invert selection
Clipboard Organise New Open Select
« v 1 T > ThisPC > b StandAlone > Standalone > v U O Search Standalone
~ -~ o . ~
& Creative Cloud Fles Name Date modified Type Size
@ SoDexe 2021-03-22 12:50 PM Application 414 K8
= This PC _ 5
) soD.exe.config 2021-04-05 2:31 PM CONFIG File 13KB
- 3D Objects [7] SoD.exe.manifest 2021-03-22 12:50 PM MANIFEST File 4x8
I Desktop [&] SoD.IEEditRemote.dll 2021-03-22 12:50 PM Application extension 1,816 KB
Documents [4] SoD.IEEditRemote x64.dll 2021-03-22 12:50 PM Application extension 2244 K8
¥ Downloads [4 SoD.Interop.UIAdIl 2021-03-22 12:50 PM Application extension 74KB
B Music [] SoD.Interop.UIA.dllmetagen 2021-03-22 12:50 PM METAGEN File 2K8
o [4] SoDkpi.dl 2021-03-22 12:50 PM Application extension 49 KB
&= Pictures
. D SoD.log 2021-04-20 2:26 PM Text Document 1KB w
B videos
v < >
249items 1 item selected 413 KB =

6. Delete the StandAlone directory.

That’s it!

Speakeasy Solutions

DAX Copilot
" Launching in

Canada
April 2025

speakeasysolutions.com | 1-888-964-9109
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